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Getting Started

This Quick Start class assumes that:

1. Apple Mail is configured for use at MIT.  If you need help with configuration please see
Apple Mail 2.0 for Mac OS X 10.4: Configure for IMAP, SMTP, and LDAP (MIT Directory)
http://itinfo.mit.edu/article.php?id=7899

2. If you are migrating from another email program such as Eudora it is assumed that
process has already taken place.  For information about migrating see Email Migration at
MIT http://web.mit.edu/ist/topics/email/migration.html

3. You are familiar with the features of at least one email program.

The Apple Mail Window

Message List

Viewer Window

Mailbox List
Toolbar Spotlight (search box)

IMAP
Mailboxes

Local
Mailbox
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The Basics: Read and Send Email

Reading Email Messages

After Apple Mail shows your messages, or after you click the Get Mail button on the toolbar, you
can read messages either in a message window or in the Viewer Window.

1. Click the Inbox icon in the Mailbox List on the left panel. This will show the mail in
your inbox or press COMMAND-1.

2. To view a message in the Viewer Window, click the message in the message list.
3. To view the message in a separate window, double-click the message in the message list.

Reply to a Message

1. With the message open in the viewer window or in a separate window click Reply, Reply

All, or Forward on the toolbar  , or press COMMAND-R,
COMMAND-SHIFT-R, or COMMAND-SHIFT-F respectively.

2. A new reply window will open into which you can type your reply.

3. Type your message, and then click the Send  button on the toolbar or press
COMMAND-SHIFT-D.

Reading Messages Stored in a Mailbox

1. Click to select the mailbox name in the Mailbox list.  Messages from that mailbox will be
displayed.  Use the scroll bar to see more messages.

2. Select the message to view it in the Viewer Window or double-click to view in a separate
window.

Reading Attachments

Attachments will appear as icons at the end of your messages. Double-click the file attachment
icon to open the file.

Saving Attachments

1. Once you’ve opened an attachment you can save from within the application.
2. To save the attachment from within Mail, click the Save button in the message header to

open the Save As dialog box.

Sending Email Messages

1. On the toolbar, click the New button or press COMMAND-N.
2. In the To: or Cc: boxes, type the e-mail address of each recipient, separating addresses

with a comma.
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3. To use the Bcc: or Reply-To: field, click the Customize Header pop-up menu in the lower-
left corner of the address area. Choose Bcc: or Reply-To: to use for the current email.
Choose Customize to add default fields to every new message header, then click OK in
the lower-right corner of the header.

4. Type a message title in the Subject field.

5. Type your message, and then click the Send button  on the toolbar or press
COMMAND-SHIFT-D.

6. To save a draft of your message to work on later, click the Save As Draft button on the
toolbar. This saves a copy in the Drafts mailbox on the mail server. You can safely close
the message and come back to it later.

Inserting Email Addresses

1. Apple Mail will automatically complete an address it recognizes from your Address Book or
from the MIT on-line directory. LDAP must be configured to look up names in the MIT
Directory.

2. Type enough letters of a person’s name or email address and a pop-up list of names will
appear. Choose the name you want.

Note: You can also choose Address Panel from the Windows menu to show a list of
addresses from your Address book.

3. The name appears as a tile which may be dragged to a different address field.  Hold the
mouse over the right end of the tile and an arrow appears.  The arrow opens a pop-up
menu with additional choices.

Sending Attachments

1. Click the Attach   button on the toolbar or press COMMAND-SHIFT-A, and then find
the file or files you wish to attach.

2. Select the file or files, and then click Choose File. The file or files will appear as icons in
the body of your message.

Check the Spelling of Messages

1. In a new message or reply message window, click Spelling on the Edit menu, then select
Spelling… from the pop-up menu or press COMMAND-: (colon).  This begins the spell
check process.

2. To customize the way your spelling checker works, click Spelling on the Edit menu, select
the Spelling option and then select Check Spelling and choose your option from the pop-
up menu.

Creating and Using Signatures

1. Choose Preferences from the Mail menu, then click Signatures.
2. Select the account for which you wish to create a signature (if applicable).  Typically this

will be IMAP Account.
3. Click the Add (+) button and enter a name for the signature, then close the window.
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4. Remove any default text and enter your signature text.
5. The default signature will be used automatically on every outgoing mail message.  To

choose a different signature or no signature on a message click the pop-up menu next to
the word Signature on the right-hand side of the header.
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Organizing Messages: IMAP and Local Mailboxes

What is IMAP?

IMAP (Internet Message Access Protocol) is a client-server approach to email in which email is
kept on MIT’s central mail server. When you work with email, Apple Mail connects to the post office
server to access your email. Since your email stays on the server, you can easily access it from
different computers at different locations, using any IMAP email client (e.g., Webmail).

You create mailboxes in Apple Mail, like in Eudora, to store groups of email messages. These
mailboxes may be created to store mail messages on MIT’s central email server, or locally on your
computer.  Knowing where your mail is located is critical to working successfully with IMAP.

View Mailboxes and Messages

1. In the mailbox list click a mailbox name. You will see a list of the messages in that mailbox
displayed in the Messages list.

2. To display sub-folders in the Mailboxes List, click the triangle to the left a mailbox. All the
sub-folders appear beneath their main mailbox.

3. To see messages in your inbox, click the Inbox icon in the mailbox list.

Create a New Mailbox

1. On the Mailbox menu, click on New Mailbox.
2. Open the pop-up menu next to Location and choose On My Mac or IMAP Account.
3. Type a name for the new mailbox.
4. Click OK.

Note: To create a mailbox folder within another mailbox, select the mailbox into which you want
to create the new folder before Step 1.

Move or Copy a Message to a Mailbox

1. Select the message and choose Move To from the Message menu.
2. Choose a destination from the pop-up menu that appears.
3. You can also move messages by dragging them from the message list to a mailbox or

from one mailbox to another. You can copy a message by holding the Option key and
dragging the message to a different mailbox.

Remove a Mailbox

1. Click the mailbox in the Mailbox list.
2. On the Mailbox menu, choose Delete then click the Delete button.

Note: You cannot delete or rename the Inbox, Drafts, Sent, Trash, , or IMAP Account mailbox.
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Deleting IMAP Email Messages

Apple Mail deletes IMAP mail in two stages.  When you select a message and click on the Delete
 button, the message is “marked” for deletion.  It may be moved to your Trash mailbox or

may remain visible in your inbox depending on your Preferences.  You may still undelete the
message until it is “purged” i.e., permanently deleted.

Delete a Message

1. In the message list, select the message.
2. On the toolbar, click the Delete button. This marks the message you want to delete.

You may hide/show messages marked for deletion by pressing COMMAND-L.
3. On the Mailbox menu, click Erase Deleted Messages and choose In All Accounts, On My

Mac, or IMAP Account. Once you choose to Erase Deleted Messages, they cannot be
recovered.

4. To undelete a message that is marked for deletion select the message and move it to the
Inbox or some other mailbox.

Preferences for the Trash Mailbox

From the Mail menu choose Preferences.  Click the Accounts icon and select IMAP Account.  Then
choose the Mailbox Behaviors tab.

Option Checked Unchecked
Move deleted messages to the
Trash mailbox

Moves messages marked for
deletion to the Trash mailbox.

Keeps messages marked for
deletion in the Inbox message
list but they are dimmed.

Store deleted messages on the
server

Moves messages to Trash
mailbox on your IMAP
Account.  These count against
your quota of storage space.

Moves messages to Trash On
My Mac, i.e., they are stored
locally.

Permanently erase messages
when:
 (will erase messages

automatically)

• when Quitting Mail – when you close the email program
• after an interval – one day, one week, or one month
• never – *if they are stored in your IMAP Account they count

against your storage quota

IMAP Quotas

MIT allots each individual 500 megabytes of storage on the central mail server.  You will be warned
when you approach 90% of your limit.  To learn more about IMAP quotas see Managing Your
Email Quota at http://web.mit.edu/ist/topics/email/manage.html. You can check your IMAP quota
via the web at https://nic.mit.edu/postoffice/quota.  This requires certificates.

You can also check your Email quota through Apple Mail.  At the bottom of the Mailbox list there is
an icon with a star and a down triangle ( see circled item in picture).
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Clicking the icon will pop-up a menu.  Choose Get Info to show the window above which shows
how much of your quota you have used.

You should be able to stay within that limit by regularly checking your current free space and by
downloading older mail or mail with large attachments from the server to your local computer.
Remember to Erase Deleted Messages.

It is also advisable to empty your Spamscreen mailbox often as this mailbox collects messages for
you.  See Spam Screening at MIT at http://web.mit.edu/ist/services/email/nospam/index.html.

Back-up your IMAP Email

All IMAP mailboxes stored on the MIT mail servers are backed up regularly in case of catastrophic
server failure. IS&T does not provide a service for restoring email that you delete from the server
intentionally or by accident. Mail lost due to server/system failure will be restored. Mail lost through
user error/deletion will not.

To back up your IMAP email, you must copy your email from your Inbox or other IMAP mailbox to a
local mailbox.  Once it is on your local machine, the mail will be backed up as part of your regular
backup routine, e.g., through TSM.  You may also wish to copy the downloaded mail onto a CD or
other external storage media.

To learn more about backing up email see Backing up Your Email at
http://web.mit.edu/ist/topics/email/backup.html.
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Working Offline

With Apple Mail it is possible to work offline if you are away from a direct connection to the internet.
Before you Go Offline you can download mail from the server to your local computer.  This allows
you to read and respond to mail when you are offline.  When you choose to work online again,
messages you marked for deletion are removed, messages in your Outbox are sent, and all other
actions taken offline are completed..

Preparing to work offline requires two steps – the first is to Synchronize the messages on your
local computer with those on the server. The second is to choose to Go Offline, which simply
breaks the connection from Apple Mail to the server.  There is not necessarily a physical
disconnection unless you are disconnecting a laptop to take to an location unconnected to the
internet.

To specify what you want to download

To manually synchronize an account:

Choose Synchronize [account name] from the Mailbox menu. If you have more than one account,
choose Mailbox, Synchronize All Accounts or Mailbox, Synchronize [account name].
Mail copies the contents of all messages to your computer. Depending on how many messages
you have, and the speed of your connection, this may take several minutes.

To be more specific about which messages and attachments you want to keep on your computer,
select the account in the Accounts pane of Mail Preferences, click Advanced, and choose an
option from the “Keep copies of messages for offline viewing” pop-up menu.

When you go offline, you're disconnected from the server, and any changes you make to
messages are made to the local copies of the messages. When you go back online, any changes
you made offline are copied to the server.

Searching for Text and Messages

To Find a Message

1. Type a word or phrase to search for in the Spotlight (search)
 box.

2. On the bottom of the Toolbar click the buttons for where you’d like to search.
- the Entire Message, the From line, To line, or Subject line
- from All Mailboxes or just the Current Mailbox

3. To return to your mailboxes clear the Spotlight search box.
4. To find text in a message press COMMAND-F and enter the search text.  Then press

COMMAND-G to find the next instance of the word or phrase.
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The Address Book and the On-Line Directory 

The Address Book provides a place to store contact information for use in managing email
addresses for Apple Mail messages, but may also be used as a general contact manager for home
and work addresses, phone and fax numbers and personal information such as birthdays or
anniversaries.  Names and email addresses in the Address Book are automatically available to the
Mail program.

Add an Address to a Message or Reply

1. If an address is in your Address Book or if LDAP is configured in your Mail program you
only need to type the first few letters of the name or email address. A list of names
beginning with the letters you type will appear.  Choose the desired name or address from
the list by double clicking.

2. You may also see all the email addresses from your Address Book in a panel directly in
the Mail program by clicking on the Address button or by choosing Address Panel in the
Window menu.  Double click an address and it’s placed in the To: field.  You may also
select a name and click the Cc: button in the panel to place the address in the Cc: field.

Add a Name to Your Address Book From a Message

In a message you are viewing or replying to, choose Add Sender to Address book from the
Message menu or press COMMAND-Y.  The name and email address are entered into your
Address book.

Add a Name from the Online Directory

An easy way to add more complete information is to look up a person in the online directory and
automatically transfer their information to the Address Book. To do this, Apple Mail must be
configured for LDAP (Lightweight Directory Access Protocol).  See Help and Information to get
more details on configuring LDAP.

1. In the Address Book, click Directories and select MIT LDAP.
2. In the Spotlight (search) box, begin to type the name or e-mail address of the person you

want to find.
3. From the names displayed, select the correct person and drag the name to All under the

Group column.  Basic information is added to the Address Book and will be available in
Mail.

4. To edit an address card select the name from the All list and click the Edit button on the
bottom middle of the card window.
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Creating Groups

With a group you can collect several email address and use the group name to address all
members in an email message.

1. In the Address Book click the plus symbol at the bottom of the Group column.
2. Type a name for the new group.
3. Click on the All icon in the Group column.
4. Drag names from the name column to the Group name you just created.  Names may

appear in multiple groups.

In a new email message simply use the group name in the To: field to send the message to all
members of the group.

Customize Mail

Customize Your Layout

The View menu gives you many options for customizing how your screen looks.  Commands under
this menu allow you to:

1. Columns – decide what information you want displayed in your messages list
2. Sort By – decide which column to sort by (you can also click the column head in the list)
3. Organize by Thread – group messages and their responses in a group
4. Hide Mailboxes
5. Hide Deleted Messages (if you have chosen NOT to send them the Trash mailbox)
6. Hide and Customize the Toolbar
7. Use Small Mailbox Icons – if you have lots of mailboxes
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Changing the Preferences in Mail

You can configure many of the options for Mail by selecting Preferences in the Mail menu.  Below
are some suggestions.

General
Mail Check Frequency - Mail will check for new messages periodically. Change the frequency in
the popup menu next to "Check for new mail". The options are in intervals of five minutes, as well
as Check Manually. Do not select the "Check Every Minute" option, as this will only cause undue
load on the e-mail servers.

Downloads (aka Attachments) -- By default, Mail stores the documents attached to any messages
you receive in an obscure folder on your computer. If you would prefer to have attachments located
in a more findable spot, change the folder selection next to "Downloads Folder". Choose "Other…"
and when prompted, select a location.

Mail Sounds - There is a small chime that plays when you receive a new message. You can
change that sound in the popup menu or choose None to avoid being disturbed while working.

Accounts
This is where you will make choices about the Mailbox Behaviors especially the Trash as
explained earlier.

Composing
Message Format – Rich Text will allow you to format your text like in a word processor.  But your
recipients must be able to read Rich Text with their email program.

Addressing – make sure Automatically complete addresses is selected

Spell Check - Change the option next to the "Check spelling" popup menu. By default it is set to
never. You can configure Mail to check your spelling as you type or when you click send.

Signatures
This is where you will create your signatures.  See instructions above.

Rules
This is where you can create rules (Filters in Eudora) to move incoming mail directly to folders
bypassing the Inbox.  See the next section.
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Using Rules to Automatically Move Messages

Mail lets you apply Rules to messages and direct those messages to mailboxes other than your
primary Inbox.  You can also change the color of the message, play a certain sound, or
automatically delete the message. You might wish to take advantage of this function to gather
traffic from a certain mailing list into one mailbox, for example.

Note: If you had filters in Eudora, those filters were converted to Rules in Mail, but they were
deactivated (the box next to the rule name is not checked). Follow the steps for setting up a
new Rule and evaluate those converted Rules to see if you can use those instead of
configuring an all new Rule.

1. From the Mail menu, select Preferences, then click on Rules.
2. Click the Add Rule button to create a new Rule.
3. Give the Rule a name (which might be the mailing list name, the sender's name, a project

name, etc).
4. Select the criteria for the messages (whether by sender, recipient, subject name, etc).
5. Configure the desired actions (move to mailbox, play sound, delete).
6. Click the OK button.

Note: Mail will prompt you to apply the rules to open mailboxes. Be careful! If you choose Yes,
you may find that older messages were migrated to the new location.

Creating a Smart Mailbox

A Smart Mailbox displays a set of email messages, stored in other mailboxes, that match specific
criteria you have defined. For example, you might create a Smart Mailbox that searches all
your mailboxes for messages from a specific sender and displays them without having to
physically move the messages between mailboxes.

You can create Smart Mailboxes that search for matching messages in a single mailbox, a group of
mailboxes, or all mailboxes. Smart Mailboxes automatically update the list of messages to include
new messages that match the criteria you defined.  When you make a change to a message
viewed through a Smart Mailbox, such as marking the message as read or unread, or moving or
deleting the message, the change is reflected in the mailbox where the message is actually stored.

1. Choose Mailbox then New Smart Mailbox.
2. Use the pop-up menus and text fields to define the search criteria  for the mailbox. If

necessary, click the Add (+) button to expand the search criteria.
3. You can also create a Smart Mailbox by using the search field in the top-right corner of the

viewer window and then clicking the Save button below the search field.
4. To change the search criteria or to rename a Smart Mailbox, choose Mailbox > Edit Smart

Mailbox. To delete a Smart Mailbox, select the mailbox and choose Mailbox > Delete.



Apple Mail Quick Start Guide v2 Page 14
http://web.mit.edu/ist/topics/email/migration.htm email-migration@mit.edu

Using Apple Mail Keyboard Shortcuts
Action Shortcut

Create new compose window Command-N

Get new mail Command-Shift-N

Open new viewer window Command-Option-N

Open Activity Viewer Command-0 (zero)

Open Page Setup dialog Command-Shift-P

Add senders to Address Book Command-Y

Apply rules to selection Command-Option-L

Use selection for Find Command-E

Find text in a single message body Command-F

Find previous Command-Shift-G

Find next Command-G

Minimize window Command-M

Display a pop-up menu with commands for
creating, sending, and retrieving mail

Press and hold the Mail icon in the Dock

Switch between different display settings in the
toolbar

Hold down the Command key and click the
toolbar button in the upper-right corner

Working with mailboxes

Open In mailbox Command-1

Open Out mailbox Command-2

Open Drafts mailbox Command-3

Open Sent mailbox Command-4

Open Trash mailbox Command-5

Open Junk mailbox Command-6

Show/hide mailboxes Command-Shift-M

Select the search field Command-Option-F

Erase junk mail Command-Option-J

Move to the last mailbox you moved or copied a
message to

Command-Option-T
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Display a pop-up menu that lets you quickly
perform several actions on the item you click

Control-click a message or mailbox

Sending messages

Add Bcc header Command-Option-B

Add Reply-To header Command-Option-R

Show/hide long headers Command-Shift-H

Attach file to message Command-Shift-A

Append selected messages to a new message Command-Option-I

Paste as quotation Command-Shift-V

Increase quote level Command-' (single quote)

Decrease quote level Command-Option-' (single quote)

Save as draft Command-S

Send message Command-Shift-D

Redirect message Command-Shift-E

Forward message Command-Shift-F

Prevent the next message from being
automatically selected (and marked as read)

Hold down the Option key when deleting a
message

Receiving messages

Select all highlighted messages Command-Shift-K

Mark as junk mail Command-Shift-J

Mark as flagged/unflagged Command-Shift-L

Mark as read/unread Command-Shift-U

Reply with iChat Command-Shift-I

Reply to sender Command-R

Reply to all Command-Shift-R

Bounce to sender Command-Shift-B

Show/hide deleted messages Command-L

Show raw source/original content Command-Option-U

Compact/empty deleted messages Command-K

Show plain text alternative Command-Option-P
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Show previous alternative (in multipart
message)

Command-[

Show next alternative (in multipart message) Command-]

Jump to selected text in message Command-J

Copy message to a different mailbox Hold down the Option key when dragging a
message to a different mailbox.

Working with fonts, formatting, and spelling

Show Font panel Command-T

Convert message to rich/plain text Command-Shift-T

Make font larger Command-+ (plus)

Make font smaller Command-- (minus)

Show Colors panel Command-Shift-C

Align left Command-{

Align center Command-|

Align right Command-}

Check spelling of email message Command-: (colon)

Flag misspelling of selected word Command-; (semi-colon)

Copy style Command-Option-C

Paste style Command-Option-V

Collapse the thread containing the selected
message (when organized by thread)

Left Arrow key

Expand the currently selected thread (when
organized by thread)

Right Arrow key

Move to next message in thread Down Arrow key

Move to previous message in thread Up Arrow key
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Help and Information

For general help with Apple Mail, see Mail Help in the Apple Mail Help menu.

For complete information about migrating from another mail client, see Email Migration at MIT.
http://web.mit.edu/ist/topics/email/migration.html

For complete information about using Mail at MIT, see Apple Mail at
http://itinfo.mit.edu/product.php?name=applemail&platform=Macintosh

For help with configuring Mail for use at MIT including LDAP, see Apple Mail 2.0 for Mac OS X
10.4: Configure for IMAP, SMTP, and LDAP (MIT Directory) http://itinfo.mit.edu/article.php?id=7899

For more on IMAP, see Guide to IMAP at MIT.
http://web.mit.edu/ist/topics/email/imap.html

For more information on backup procedures, see Backing up Your Email
http://web.mit.edu/ist/topics/email/backup.html.

For general information about using email at MIT, see Email at MIT.
http://web.mit.edu/ist/topics/email/index.html

For help with email or other computer questions, contact the Computing Helpdesk.
computing-help@mit.edu      617-253-1101


